Discoverer Plus/ODS
Finance Module

ODS (Operational Data Store): Database
Discoverer Plus: Reporting Tool

Connect to ODS Database using Internet Explorer

Log-In

From the Banner/ExpressLane login page at http://www.lanecc.edu/explanestaff/ click on
Discoverer Plus.

Your user name should be the same as Banner, last name + first initial

Enter password, click Connect.

Select a Report - Database > Open

The Report menu

2 Open Workbook from Database @

Choose atarget worksheet by browsing availahle warkhooks and selecting a worksheet

e [AIIWurkbunks "‘ [% "‘ Mame contains: | IM
Workhooks:
kame = Onener todified
= s Z_FDMO100 Maonthly Division Activity by Budget FOAP FIMADMIMN May 4, 2006 3:58 P
) LCC_FDMO110 Manthly Dept Activity by Budget FOAP FIMNADMIM May 4, 2006 4:02 PM
& @ LCC_FDMO120 Manthly AUnit Activity by Budget FOAP FINADMIN May 4, 2006 4:05 P
& @ LCC_FDO0100 FOAR Hierarchies FINADMIN Jul 17,2007 10:20 A

£33 '@ LCC_FDY0100 Fiscal Year-Period YTD Expense Comparison by Acct Type FIMADMIN Dec 11, 2008 227 P
5 @ LCC_FDYO0110 Fiscal Year-Period YTD Revenue Comparisan by Acct Type FIMADMIMN Jul 3, 2007 11:20 AW
52 @ LCC_FDY0130 Fiscal Year-Period FSFD Expense Comparison by Acct Type  FINADMIN Dec 11, 2006 315 PM
>3 @ LCC_FDY0140 Fiscal Year-Period FSPD Revenue Comparison by Acct Type  FINADMIN Jul 3, 2007 11:19 Al

& @ LCC_FDY0200 Club Account Activity FINADMIN - Apri0, 2007 2:14 P
£33 '@ LCC_FOY0210 Open Purchase Orders by Liser FIMADMIN Jun 8, 2007 9:09 Ahd

5 @ LCC_FFYD120%TD Expenditures by Dept ar Program within Fund Group FIMADMIMN Dec 11, 2006 9:25 AM
& @ LCC_FGMO100 Manthly Grant Activity Repart by Budget FOAP FINADMIN Oct10, 2008 2:21 PM
>3 @ LCC_FoY0200 Grants and Contracts Revenues by Fiscal Year FIMADRMIN Qct11, 2006 5:59 A
£33 '@ LCC_FGY0210 Open Grant Purchase Orders for a Fiscal Year FIMADMIN Jun 14, 2007 8:47 A
£33 @ LCC_FXy0100 Capital Assets Replacement Forecast- CARF FIMADMIN Apr 26, 2007 413 P

~Description

Reports one month's (fiscal period) activity for a selected division.
For each hudget foap, shows month's beginning balance, all activity posted to that budget foap during the month, and the ending
balance.

Help ( Cpen )( Zancel jl

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

Report Definitions as of 07.26.07

Finance Activity by Budget FOAP

FDMO0100 Monthly Division Activity by Budget FOAP:
» Reports one month’s (fiscal period) activity for a selected division. For each budget FOAP,
shown month’s beginning balance, all activity posted to that budget FOAP during the month,
and the ending balance.

FDMO01100 Monthly Dept Activity by Budget FOAP:
» Reports one month’s (fiscal period) activity for one or more selected departments. For each
budget FOAP, shown month’s beginning balance, all activity posted to that budget FOAP
during the month, and the ending balance.

FDMO0120 Monthly AUnit Activity by Budget FOAP:
» Reports one month’s (fiscal period) activity for one or more selected activity units (sub
departments). For each budget FOAP, shown month’s beginning balance, all activity posted
to that budget FOAP during the month, and the ending balance.

Fiscal Period Revenue or Expense Comparison by Account Type

FDYO0100 Fiscal Year-Period YTD Expense Comparison by Acct Type:
» Runs a crosstab report of expenses with fiscal period and fiscal year on the left and account
type on the top. Reports accounted budget, actual, and encumbrance amounts. Tabs to
select by division, department, activity unit, or data entry origin.

FDY0110 Fiscal Year-Period YTD Revenue Comparison by Acct Type:
» Runs a crosstab report of revenues with fiscal period and fiscal year on the left and account
type on the top. Reports accounted budget, actual, and encumbrance amounts.

FDY0130 Fiscal Year-Period FSPD Expense Comparison by Acct Type:
» Runs a crosstab report of fiscal period actual expenses with fiscal period and year on the left
and account type on the top. Tabs for entire collect, select by division, dept, activity unit or
data entry orgn.

FDY0140 Fiscal Year-Period FSPD Revenue Comparison by Acct Type:
» Runs a crosstab report of fiscal period revenues with fiscal period and year on the left and
account type on the top. Tabs for entire collect, select by division, dept, activity unit or data
entry orgn.

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
Last update: 07.26.07 Page 2 of 10




Discoverer Plus/ODS
Finance Module

Other Reports by Dept or User

FDY0200 Club Account Activity
» Reports year to date activity in club accounts for a selected fiscal year up through requested
period.

FDY0210 Open (completed and approved) Purchase Orders by User
» Request a fiscal year and one or more user IDs

Grants and Contracts Reports

FGMO0100 Monthly Grant Activity Report by Budget FOAP
» Reports one month’s (fiscal period) activity for one or more selected grants. For each budget
FOAP, shows month’s beginning balance, all activity posted to that budget FOAP during the
month, and ending balance.

FGYO0200 Grants and Contracts Revenues by Fiscal Year
» Grants and Contracts revenue summary and detail by budget FOAP. Excludes funds that
begin with 86 or 87.

FGY0210 Open Grant Purchase Orders for a Fiscal Year
» List opens Purchase Orders that contain Grant items, for a requested Fiscal Year.

High Level Reports

FDOO0100 FOAP Hierarchies
» Lists FOAP hierarchies. Each element is on a separate table.

FFY0120 YTD Expenditures by Dept within Fund Group
» YTD Expenditures by Category (personnel, M& S, Capital Outlay) within Fund Group (1st
digit of fund) and Department.

FXY0100 Capital Assets Replacement Forecast — CARF
» Lists capital assets grouped by user to be replaced. Excludes disposed assets, land,
buildings, and improvements and assets not acquired in a fiscal year earlier than the
requested year.

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

Run Reports
SAMPLE PARAMETER SET BASED ON FINANCE ACTIVITY BY BUDGET FOAP

Open Workbook From Database - Select desired report, Double click to open the selection of
tabs. To save time, select and open on the tab you wish to query. | chose Combined — Report for

this demonstration.

e | Open Workbook from Database @

Choose atarget worksheet by browsing available workbooks and selecting a worksheet

WiEw: [AIIWnrkanks v| [% v| Mame contains: | IC!ear
Workbhooks:

Marme Dhwher Modified

= @ Lz _FDMO100 Manthly Division Activite by Budoet FOAR FIMADMIM May 4, 2006 3 =

—': Lz FDMO110 Manthly Dept Activity by Budget FOAP FIRAD MM May 4, 2006 4
i Expenditures - Report
] revenues - Repart
T combined - Repaort —
| Expenditures - xls format
M revenues - ¥ls format
[ cormbined - ¥ls forrmat

[ @ LZC_ FDORMO120 Monthly Alnit Activity by Budget FOAP FIFAD MM hlay 4, 2006 4
[ @ LCZ FOOO100 FOAP Hierarchies FIFAD MM Jul 17, 2007 1™
1| | 3

—Description

Reports one maonth's fiscal period) activity for one ar mare selected depts.
For each budget foap, shows month's beginning balance, all activity posted to that budoget foap during
the month, and the ending balance.

Help ( Qpen )( Cancel JI

Edit Parameter Values - by selecting from drop down boxes or type in.

2 Edit Parameter Values

Selectvalues for the following parameters:
Enter Desired Fiscal Year as Y™ IEDDT @
Enterthe fiscal period that represents the month's activity you want to report. See legend below *: i'1 T @
Enter the Desired Department(s) {mustinclude department title). Mo wildcard allowed *: I'453DDD - Foodservices'
Enter desired fundis). Wild card (%) QOK.* |% [g
~Description

*indicates required field.

(" Help ( ok j( canel

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

Fiscal Year: Enter or select the (four digit) fiscal year (YYYY).

Fiscal Period: Enter the two digit number that corresponds to the fiscal month ex: July = 01. A
legend pops up in the description box below when you click that field.

A Select Values @

Select multiple values fram the list. The values are displaved in groups of
100. Division, Department

or Activity Unit
| (according to the
report you have
Search by [5tarts with '| selected) number
and Title - In order to

l = facilitate accurate

W Case-sensitive ZeleCtiona the
escriptions are

Unit Code:

Search in: [Value

Search far: |453

Displayed values: Selected values:
i ! attached to the org
@ 453000 - Foodservices number. Therefore
you must enter the
number and

description for ODS
to select the correct
data.

fom '} ﬂ E m E E ﬂ ﬁ:‘ E @ gl r 4 3 Novell .,

Three ways to select:
1. Enter the number and org description; must exactly match the list.
2. Open the drop-down list and pick from the list (see figure above).
3. Enter beginning known numbers in the Search For field, and click Go. ODS will retrieve and
display all enterable values. Select desired values. Single arrow over to the right box, or
click >> to select all retrieved values.

Fund: Leave % for all funds or enter fund number to limit the data to retrieve. You can select
multiple, non-contiguous funds if you open the drop down list of values, or enter as
111100’,'111200’ in single quotes separated by a comma and no spaces.

Click OK to run the query.

ODS is not known for speed, however its flexibility more than makes up for the few minutes your
qguery will take to run. This delay is a good reason to select the tab you desire when you first select
the report. Note tab names. ReportName.xls tabs are formatted to export to Excel. You may think
the others print nicely right from ODS.

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS

Finance Module

A http:#exp.lanecc.edu: 7777 - FINADMIN.LCC_FDMO110 Monthly Dept Activity by Budget FOAP - Oracle - Microsoft Internet Explorer

File Edit View Format Tools Help

VG S A T. DMl

Arial

|l - [B] g u

....._ _ n@ %

BEIE

T Expenditures - Repart

ClRrevenues - Report

“W_._ Applet oracle, disco.DiscoApplet skarted

Page Iterns: | Fiszal Year: zo07 1_” Fiscal Period: 12 1_
Dept Fund Budget Fozp Betuzl Org £ Bcet Moot Desc Trans Date Trans Desc Dacurm. Aectd Bdgt Retual Encumb. Differ.
452000 - B11200 - Campus  [G11200- 45:3100- ) . A Y
MNetWroming Capital B Bal ool -178.4852.00 0.0 7885200 —
Foodsemices |Foodsemices 470500- 310000 S R —
MNet'orking Rewersal of HWC from
4523100-474000 0530 Foooa04 0.00 178 .552.00 0.o0| -178,552.00
Capital-Unrestricted JOO457 44
End Balance 0.00 0.00 0.00 0.00
G11200- 453100- Sale of Goods and _—
B Bal 1,600,000.00) 1,275 530 .55 0.00| 324,4909.45
420100- 310000 Senvices A
4523100-420260 | Sales- Food Q&1 Centar Food Sales5-20 FoOOgT? 0.00 448530 .00 4,485,230
G107 WISA
45:2100-420260 | Sales - Food Q&1 FOODSERVICE JO0MG166 0.00 1.221.00 .00 -1,221.00
45:2100-420260 | Sales - Food 0604 [Center Food Sales5-31 FOOQETTS 0.00 436255 .00 -4,262.85
G407 WISA
452100-420260 | Sales - Food 0E 04 FOODSERVICES JO0qg180 0.00 197020 .00 -1,870.30
452100-420260 | Sales - Food 05105 Centar Food Sales 61 FooQgTag 0.00 249720 .00 -2,497.20
452100-420260 | Sales - Food 06058 (060507 visa foodsenices [ JOOIG226 0.00 242430 .00 -2,484.30
45:2100-420260 | Sales - Food 0506 Center Food Sales FooQz00 0.00 433726 .00 -4,237 26
4523100-420260 | Sales- Food 0606 (060607 visa foodsenice [JOOIG216 0.00 222035 .00 -2,220.35
4523100-420260 | Sales- Food osmo7 Center Food SalesG-5 FOOQ2206 0.00 4.840.15 .00 -4.240.15
OGO7O7 WISA
4523100-420260 | Sales- Food osmo7 FOODSERVICE JO0MG225 0.00 1.883.05 .00 -1,88205
45:2100-420260 | Sales - Food [l=Rints) Center Food SalesG-6 Fooosz09 0.00 4,192.85 .00 -4,192.85
4523100-420260 | Sales- Food 0608 (060207 visa foodsenice |[JOOIG2S56 0.00 1.402.95 .00 -1,402.95
4523100-420260 | Sales- Food Q&M Center Food SalesG-7 Foooa14 0.00 3.781.25 .00 -3,781.25
O 107 WISA
4523100-420260 | Sales- Food Q&M FOODSERVICE JO0MG2T3 0.00 1.452.80 .00 -1,452.80
45:2100-420260 | Sales - Food g2 Center Food SalesG-2 FooQgg:29 0.00 2,850 65 .00 -2, 25065
4523100-420260 | Sales- Food 06M2  [0GM200T visa foodsenice |[JOOIG226 0.00 1.052.90 .00 -1,059.90
4523100-420260 | Sales- Food 0g/M2 Center Food Sales FOOQ2252 0.00 3,220,058 .00 -3,220005
453100-490260 | Sales - Food oprrg | IO 19007 visa JOD1E304 oool  1oreeol  ooo|  oveso|T
—
Double-click here to edit the text area

ClEwmenditures - ws format - CIRevenues - wis format

I Gombined - ¥ls farmat

G Internet

For additional information, please contact Laura at martinl@Ilanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

Notice the beginning balance is carried forward from the previous period, which is year to date as of
06.01.07 in this illustration. Then each transaction is presented by budget FOAP, with the actual

Org and Program in the next column — fund and program will always be the same between budget
and actual FOAPs.

Exporting Data to Excel - .xIs formatted tabs
There are two ways to export data to Excel

File > Export... (Recommended)

(Allows control of the location and file name)
» Wizard Step 1: Choose Current or All worksheets in file to export

» Wizard Step 2: Browse to desired file location and change file name

File Type: [ Microsoft Excel Warkhoaok (*.xls)

Location: |- Desktap -| [_ @

[ My Documents

[ My Computer

[T My Metwork Places
[ Adohe

(7] Bookstore - Lisa
[ cML-ICs

[ COLLFINLAPTOPC

|
Files: &llF= =

File Mame: IFuudEewices Cept Activity by Budget FOAP Per 12 - FY07 xls

( Save )( Cancel)

If you do not change the file name, the next time you export the same
report to the same location, it will overwrite your saved data.

» Wizard Step 3: Review and accept or change parameters
» Wizard Step 4: Accept Supervised

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

Even though this check
box is selected, Excel will ‘
rarely automatically open
the exported sheet.

7 first exported sheet

Security Warning E3 When prompted, Enable Macros
"CHDocuments and SettingsimartinlDesktoptFoodServices Dept Activity by (there aren’t macros inClUded, itis
Budget FOAP Per 12 - FY07 . xls" contains macros. part of the ODS upersona“tyn)
Your Macro Security setting must
be set at Medium for this to work.
Macros may conkain viruses, It is usually safe o disable macros, but if the To Change1 from the menu select:
macros are leqitimate, wou might lose some Functionalitsy:,
Tools > Options > Security > Macro
[ Disable Macros ] [ Enable Macros ] [ Mare Info ] Security > Medium.

If you selected an .xls tab, each line in the department, fund and budget FOAP column would repeat
the same information so that you can use Excel to format your report as desired. Here are a few
lines so you can compare the format to the example on page 6.

Microsoft Excel - FoodServices Dept Activity by Budget FOAP Per 12 - FYDT.xls - |E||1|
E] Fle Edt Yiew Insert Format Tocls Data  Window  Help Type aquestion forhelp » o @ X
NEHREGRITERIFIZ-4w - @i -8 -|B IE]E=E % RSB EE-H-A-H

a a =] a kE . X3 o o a a = -,
Subtotals., mm 5= o =0E =0 B A B VMC-DATAZ\DATAZ\INTERMALCTRLS\Finance Process Documents), - || W ee|=EC| AP QA BHEH LS '&B
G5 - f Sales - Food
A B [ b E F [E] H | d K L It B
Actual Ory [ Trans
1 FSYR | FSPD |Dept Fund Budget Foap Acct 4 Acct Desc Date Trans Desc Docum. | Acctd Bdgt | Actual Encurmb.
2007 2 (453000 - BU200- Campus | EH200- 453100-
DOperational Suppli Eeginning Bal -40,900.00 2801240 989271
112 Foodservices  |Foodservices E10000- 310000 IS L sl
2007 2 | 453000 - G200 - Campus | 611200 453100
453M00-B10000 | Operational Suppli mens |t ti JO01ES24 -15,000.00 0.00 0.00
113 Foodsemices  |Foodservices EA0000- 20000 ISR L Sl -
2007 12 | 453000 - E11200- C. E11200- 453100- 1t Haod Chemical
, S 45300610700 | Cleaning Supplies 0B#Z5 AadEnEMEE orzzaas 000 5640 5640
114 Foodsemices  |Foodservices E10000- 310000 Corp
2007 12 453000 - Elz00 - E1200- 453100- ht Hood Chemical
, S 450010700 | Cleaning Supplies 05425 oA EIEMER igr2zzas 0.00 57420 57430
115 Foodservices  |Foodservices E10000- 210000 Corp
2007 2 | 453000 - Bl200 - E200- 453100- Mt Hood Chermical
. AmpuE 4E3N0BI0700 | Cleaning Supplies 08#30 e infzzeze .00 5750 57.50

116 Foodsemvices  |Foodservices E10000- 310000 Corp -
ERE blr\l:umbined—:-:lsfurmatf |<| | r
Ready ML o

2. File > Export to Excel (Not Recommended)

This sends the file to a preset location that is somewhat difficult to find, and uses the report name
for the file name. If you save the same report with different parameters, it will wipe out the
previously saved report. It does work well for a quick look at a report.

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

In Discoverer Plus, from the Tools menu select Options and configure the General and Query
Governor tabs as follows:

x

Query Governor Sheet Formats  Adwvanced ELIL

Warkbooks

After opening a workbook:
1 Run query automatically
0 Dop't run guery (leave sheet emptyd

w Ask for confirmation

Wiorkbooks in recently used list: |9 - entries

Scheduled Workbooks

[ Dian't show the new results window atter initial connection

[ Don't show expired results on exit, delete results automatically

Wizards

v Showy wizard graphics

Measurement unit

Measurement unit forworkbooks:

Help ( Ok )( cancel J

x

Sheet Formats  Advanced ELIL

General

Summary Data

Summary data can be set up by yvour Discoverer manager to improve performance.
Withen doyouwantto use summary data?

® Alvays, when available
0 Qnly when summary data is not out of date (stale)
0 MWever

Cllery Governar

W Wiarn me if predicted quers time exceeds: |5:00 2 mins:secs

-

[ Prevent queties from running londer than: [10:00 2 ming:secs
[T Limit retrieved query data ta; 10000 L rows

Retrieve data incrementally in groups of 10000 o rows

Cancel list-ofwalues retrieval after: 215 2 mins:secs

-

RN

T Hew ( ok ) cancel |

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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Discoverer Plus/ODS
Finance Module

On the sheet tab, select and deselect the boxes and notice how the display responds. Choose the
option(s) that best suit your preferences.

x

General QB GOvernor Formats  Advanced ELUL

Tahle headers Example
I Show calumn headings [ Show row numbers Tahle
Table Titla
Column width: [ se auto width - Columni  ColumnZ  Columnd
a1 3z 10
Crosstab headers a0 65 19
44 73 5
v Show item |abels v Show heading gridlines a1 B2 T
Crogstah style: v 30 heading gridlines e —————
Tahle and crosstab data area Crosstab
Crosstab Title
v Showe vertical gridlines Gridline color; [[J | kem3 Column1 | Columnz
. I | kem1 |~||tem2
I Show hatizontal gridlines - 105 170
Rowl,1 a1 2
Sheet content Fow! 2 0 85
v Show title v Show text area Rowl,3 44 73
Crosstab Tert Are
Show null values as: [ - s e a

[ Help ( ok ) cancel |

Icon Legend -

Open new Report — return to menu

Print Preview - NEW

&6 g

Change parameters in existing report

For additional information, please contact Laura at martinl@lanecc.edu or call xX5795
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